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INTRODUCTION

We are pleased to announce the availability of the new version of Geomagic Verify. Geomagic Verify is powerful, easy first article inspection
software for both contact and non-contact 3D measurement devices. It lets you measure and compare parts to CAD models to find and fix
manufacturing defects before they become major problems.
New features in this version were made to improve the 3D scanning workflow using 3D portable measurement device for users and to make it
easier to use without manual intervention in the front of computer.
Many other enhancements have been made to existing features to give users more power in their scanning, inspection, reporting, and to
improve the user’s experience. Especially, new attempts in 3D inspection reporting technologies were in this release.
For more information, please visit www.geomagic.com.

WHAT’S NEW
Highlighted Functions
•

Enhanced Scanning Workflow in LiveCapture
The LiveCapture has been enhanced so that users can continue to do scanning jobs even though the device’s coordinate system or the
scanning object is repositioned. In this new version, users can now change the device’s coordination system or move the scanning object
during the scanning job in LiveCapture by selecting the Change Position option.

This enhancement enables users to move the device or reposition the scanning object during the scanning job when the view point of the
scanning device in the current position can not cover the interested scanning area of the object.
For more information, see LiveCapture section in User Guide found at ~<Installation Path>\3D Systems\Geomagic Verify\UserGuide, or press
F1 in the application when the LiveCapture performs.

•

Enhanced Geomagic Capture
The Geomagic Capture user interface has been highly enhanced so that users can align the scans without leaving the command. It also
enables the users to use multiple scanning devices at a time as well as to use a turn table during the scanning. This saves scanning time
and makes the scanning process much faster than before. For more information, refer to Geomagic Capture User Guide.
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Geomagic Capture User Interface At a Glance
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A

View Window

Displays current camera view.

B

Scanner Tab

Allows users to switch each
scanner’s camera view.

C

Camera View Switch

Allows users to select which
camera view to show in View
Window.

D

Starting Position
of 360º Rotational
Scanning

Indicates the starting point of 360
degrees rotational scanning.

E

Scanning Button

Starts the scanning.

F

Capturing Options

Allow users to easily manage their
working environment and scan an
object with optimal results.

G

Exposure Settings

Allows users to adjust an exposure
value.

H

Turntable Settings

Allows users to adjust the number
of scan divisions in 360 degrees
rotation.

I

Status Bar

Shows the current working status.

J

Settings

Goes to the settings menu.

K

Help

Shows the Help document.

A

Automatic Alignment Aligns scans with various
Methods
automatic alignment methods.

B

Resolution

C

Aligns the coordination systems
Automatic Alignment
between multiple scanners using
Methods for Multiple
various automatic alignment
Scanners
methods.

D

Device List

Manages scanners.

E

Network
Configuration

Configures network connections
to communicate with scanners.

F

Firmware Update

Updates firmware via file.

G

Back

Goes back to the scanning menu.

H

Help

Shows the Help document.

Adjusts the resolutions of
scanners.

Displaying Multiple Scanner Views
The Camera View now allows users to switch between scanner views. This is available when multiple scanners are connected. Users can
check camera views by navigating scanner tabs associated to each scanner.

Switching Camera Views
Left and Right Camera views have been added so that users can check both side views before scanning an object.
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New Capturing Options
New scanning options, Easy Scan, Reduce Noise, Last Scan, and Delete Last Scan have been added in Scanning dialog window.
All options were redesigned to allow users to easily manage their working environment and scan objects with optimal results.

Automatically determines the best exposure settings then captures an object.

A

Easy Scan

B

HDR

Scans multiple times at varying exposure levels in order to capture large contrast variances for
scanned objects.

C

High Sensitivity

Special capturing option which allows for capturing of difficult-to-capture noisy surfaces, such as hair.

D

Reduce Noise

Minimizes waves or ripples that may be cause by tiny movements or ambient vibration during a
capture process.

E

Last Scan

Displays the last set of scan shots created.

F

Delete Last Scan

Deletes the last scan data created.

Note: HDR is used during the capturing process if necessary

New Slide Bar for Turntable
A new slide bar for adjusting the number of scans taken in a single 360 degrees rotation has been added in Scanning dialog window. This
slide bar is displayed when a turntable is connected to Geomagic Capture interface.

Before Scanning

During Scanning

A

Starting Position

Shows the starting position of a scan

B

Slide Bar for Turntable

Enables users to adjust the number of scans in 360 degrees rotation

C

Current Position

While scanning an object, small triangles will be highlighted in blue to show which position a
scanner is currently capturing in a 360 degree rotation.

While adjusting the number of scans in the slide bar, the rotation indicator will dynamically change around the Scan button accordingly.
When scanning is automatically performed, the rotation indicator will show where on a part a scanner is facing in 360 rotational degrees as
well as how many times a scan was performed.
Note: A turntable needs to be connected to the application to automatically scan an object using the turntable functionality.
3D Systems, Inc.
4

New Alignment Method using a Turntable
A new alignment method named Turntable has been added within the Auto Align options. This method enables users to easily scan an
object in a 360 degrees rotation and align all scan shots automatically without any manual intervention. This alignment method is available when a turntable is connected.

Management of Multiple Scanners
Multiple scanners can be connected to Geomagic Capture interface at the same time and used to gather more scan data than is possible
using a single scanner. All connected scanners can be managed within the Device List in Settings dialog window. Users can configure the
network settings for each scanner by checking on/off the device in the list.
Note: A new dialog section for the alignment between the coordinate system of multiple scanners will be displayed in Settings
dialog window when multiple scanners are connected to Geomagic Capture interface.

New Alignment Method for Multiple Scanners
A new alignment methods for multiple scanners have been added in Setting dialog window.
Three different alignment methods, Sphere, Best Fit, and Target Markers are provided for the alignment between the coordinate system
of connected multiple scanners. Once the coordinate systems of each scanner have been aligned, scan data scanned by each scanner will
be created in the application as they are being aligned and paired. If scan data scanned by each scanner have already been aligned using
other alignment methods provided in the application, the transform matrix between the coordinate system of each scanner can be updated to Geomagic Capture interface and used for later scanning.
Alignment methods are:
•

Spheres - Used when aligning the scanned parts with spherical features or reference datum balls

•

Best Fit - Used when aligning scanned parts using the whole shape information of a part

•

Target Markers - Used when aligning scanned parts with target markers

Note: The Multiple-Scanner Alignment dialog section will be displayed and the alignment methods within the dialog section will
be available when multiple scanners are connected to Geomagic Capture interface.
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Enhancements
•

New Jig Inspection Workflow
A new Jig inspection workflow using the liveInspect has finally been accomplished by availability of probed points for RPS alignment. Now
users can probe points at specific positions and use them for the RPS alignment. All the points probed in LiveGeometry can be projected
onto the pre-probed planes and use them as reference points during the alignment.
After the alignment is performed, users can freely inspect according to the inspection instruction.
For more information, see LiveGeometry section in User Guide found at ~<Installation Path>\3D Systems\Geomagic Verify\UserGuide, or
press F1 in the application when the LiveGeometry command performs.

•

New Guide in Mouse Helper
By newly added availability of probed point projection on plane, new guide image and instruction have also been added in the Mouse
Help. It helps users to create a probe point on the projection plane in correct way. The Mouse Helper will be displayed when creating a
point on planer face in LiveDimension or LiveGeometry.

•

Using Existing Ref. Geometries in Position Device
While moving the measuring device’s coordination system by using the Position Device command, users can now use existing Ref. Geometries which have been created from Scan data in the previous process. The action guide in the mouse helper has also been updated
accordingly.
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•

Adjustable the size of InfoCenter
A new option named InfoCenter Size has been added within the General tab in the LiveInspect Setting.
This option enables users to adjust the size of InfoCenter so that the position of the measurement device and the results can be readable
during scanning or measuring in LiveInspect.

•

New Partial Deviation
A new option named Use Selected Data Only has been added in the More Options of Whole Deviation command.

This option enables users to check the deviation between nominal and scan data for selected faces or regions only. This is very useful when
user needs to check the deviation plot on the partial areas from the big size of data.

For more information, see Whole Deviation section in User Guide found at ~<Installation Path>\3D Systems\Geomagic Verify\UserGuide, or
press F1 in the application when the Whole Deviation command performs.
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•

Adding Simulated CMM Points by Importing a File
A new method named From File has been added in the Add Simulated CMM Point command. It enables users to add multiple simulated
CMM points at a time by simply importing file such as .TXT (Text) or CSV (Comma Separated Value) file formatted by ASCII code.
The application extracts the position information (X, Y, and Z) of each point as well as its measuring direction (I, J, and K) from the file and
uses those information to add simulated CMM points. If necessary, users can manually define the search methods of each CMM points for
scan data after the file is imported.

For more information, see Add Simulated CMM Point section in User Guide found at ~<Installation Path>\3D Systems\Geomagic Verify\
UserGuide, or press F1 in the application when the Add Simulated CMM Point command performs.

•

Expanded Availability of Filtering Options
Users can now apply the Filtering Options controlled in the Face entity’s property to all GTol inspection features. If a file has been saved
with GD&T features in the previous version of the application, the GD&T features will be rebuilt while opening the file in the this version.
Note: If the type of target face entity is freeform or boundary edge of hole that cannot obtain scan pair points by using the zone
fitting method, the Geometric Tolerance defined on the target features will be exempted from the filtering option’s control.

•

New Reporting Tool
New attempts in 3D inspection reporting technologies were in this release. This is still in Beta, but it offers various functions and options so
that users can experience this new reporting tool and apply it for thier inspection project. This new reporting tool allows users to import a
Microsoft Word document formatted by .DOCX file format and used it as a report template. It also enables users to easily customize a page
layout as in Microsoft Word and quickly add inspection items by dragging and dropping built-in information and use it for thier repeatable
inspection project.
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2

INSTALLATION GUIDE

SYSTEM REQUIREMENTS
•

•

•

Hardware: The minimum hardware requirements are listed below. More memory will allow for larger models to be processed.
•

Processor: Intel® and AMD® processors, 2-GHz or above

•

RAM: 4 GB

•

Hard Disk: 30GB or more recommended (temporary file cache requires about 3 GB free disk space for every 100 million points)

•

Graphics Card: OpenGL 1.2 or above, 32 bit true color

•

For more details, refer to the System Requirement at: https://rapidform.zendesk.com/entries/20237017--XOR-XOV-XOS-System-Requirements

Operating System: Supported operating systems are listed below.
•

Windows Vista (32-bit or 64-bit SP1 or above)

•

Windows 7 (32-bit or 64-bit)

•

Windows 8 (32-bit or 64-bit)

Third-Party Application: Microsoft Office 2007 or newer (for Verify’s reporting), Microsoft .NET Framework 4.0

DOWNLOAD SOFTWARE
When the Update Product Automatically option is set to True in Preferences and a valid maintenance code is activated and your computer is
connected to the Internet, the application will check if a newer version is available and will download it automatically for installation. By going to
Help > Check For Update, you can also manually check for the updates. This command updates the product to the latest available version.

INSTALLATION STEPS
Please follow these steps to complete the upgrade.
1.

Download the zip file from the Geomagic Support Center at: http://support1.geomagic.com/ics/support/kbanswer.
asp?deptID=5668&task=knowledge&questionID=2191.

2.

Unzip the zip file to a temporary directory.

3.

Double-click the .exe file and follow the instructions.

Note: After installation, the update can be verified by running the application and checking the version by going to Help > About.

ACTIVATE LICENSE
The Geomagic Verify requires license activation to be run in your computer. If you are an existing customer and have already activated the
license in your computer with the previous version of the application, you can run the new version of the application without re-activating the
license. If this is your first time to run the application, you will need to activate a license in the License Activation dialog window after launching
the application.

For more information, please visit Geomagic Support Center at: http://support1.geomagic.com/link/portal/5605/5668/ArticleFolder/348/
Geomagic-Verify.
3D Systems, Inc.
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FIXED BUGS

Below are a list of bugs fixed in the application.
•

The bonus tolerance in Geometric Tolerance would not be updated after the dimension tolerance was changed. This bug has been fixed.

•

Hotkey assignment within the Hotkey tab in the LiveInspect Settings sometimes did not work immediately when users pressed a key on
the keyboard. This bug has been fixed.

•

When users selected a wrong entity, the application would sometimes crash. For example, if users select a Ref. Circle while a planar
entity needs to be selected, the application would crash. This bug has been fixed.

•

While a feature controlled by a line profile or a surface profile without the definition of datums was being inspected, some defects were
found in the calculation of the initial best-fit alignment between nominal geometry and scan pair geometry found from scan pair points and
it would sometimes make wrong results in some case. The best-fit alignment algorithm has been enhanced so that it can cover the case.

•

The application would sometimes crash after replacing the nominal data from the existing inspection project. This bug has been fixed.

•

While probing a point to make a local plane on the freeform face, undoing would incorrectly work and the number of probed points would
not be correctly updated in the InfoCenter. This bug has been fixed.

•

While a feature controlled by GD&T with material conditions (MMC/LMC) was being inspected, some defects were found in the initial
bonus tolerance calculation algorithm. This bug has been fixed.

•

3-2-1 alignment would incorrectly work in some cases. This bug has been fixed.

•

The application would crash when a transform matrix was imported by file (.TRM). It occurred when users set up an inspection project
with no scan data, and when defining Transform inspection feature with a transform matrix by going to Insert > Align > Transform. This
bug has been fixed.

•

When a Ref. Circle was created from section polylines, there was an issue that the Preview and the OK buttons were differently work.
This bug has been fixed.

•

Even though 3D dimensions were in 3D GD&T mode, the Organize Dimension command was not activated in the mode. This bug has
been fixed so that the Organize Dimension command can be used no matter in which mode users are working.

•

The section deviation results would not be updated after the Min. Distance Sub-Method was changed to Normalize. The results were correctly displayed only when users edited the section by selecting the Edit Section Setup menu within the popup menus on the Inspection
Feature tree. This bug has been fixed.

•

The application would sometimes crash while the Volume Merge command within the Add-in menus is being applied to multiple scans.
This bug has been fixed.

•

If reference positions were defined with simulated CMM points in RPS alignment, transform matrix would not be updated after the alignment performed in Play LiveInspect Process. This bug has been fixed.

•

Options within the Projection Direction and the More Options in the Whole Deviation command would be incorrectly displayed while navigating the stages. This bug has been fixed.

•

The application would sometimes crash when users canceled the operations in the Position Device command by pressing the Cancel
button. This bug has been fixed.

•

There was an issue that the files could not reopened in the application if the file contains viewpoints that captured deviation tags. This bug
has been fixed.

•

The LiveAlign command would always be highlighted and would be blocked to be rerun after exiting the command by clicking the Cancel
button or pressing ESC key from the point where users are working in the Transform Operation. This occurs when users are working with
Nominal data. This bug has been fixed.

•

In Position Device command, the deviation results between reference and new position would not be updated after the points were reprobed in the new position. This bug has been fixed.

•

The runout could not be inspected with probed points even though the points were enough for the calculation. This bug has been fixed.

•

When users edited the property of the Ref. Point after creating it in LiveGeometry, options within the Probe Options would not be maintained comparing to the options when it was created. This bug has been fixed.

•

When generating an inspection report, some of inspected features would not be listed within the Model Tree in the Generate Report
dialog window. This bug has been fixed.

•

The application could not keep the toolbar changes. This bug has been fixed.

•

The Distance command would incorrectly work when measuring two vectors. This bug has been fixed.
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•

The application would crash when reconnecting Geomagic Capture after terminating its process in the windows task manager. This bug
has been fixed.

•

When measuring dimensions, the actual value in the results would sometimes incorrectly displayed. This bug has been fixed.

•

When users tried to set the IP address manually in Geomagic Capture interface, the interface would prompt: “Configuring Network...” in
the status line and would hang. This bug has been fixed.

•

Some of the wording and tool tips in Scanning or Settings dialog window in Geomagic Capture interface made users confused. They have
been revised or renamed.

•

When users closed Geomagic Capture interface by pressing Alt and F4 keys, the application would sometimes crash. This bug has been
fixed.

•

Scanner projectors would not turn off after leaving the Geomagic Capture command. This bug has been fixed.
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